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Introduction aee

P Creating forms for your database can make entering data much more convenient. When you
create a form, you can design it in a way that works with your database and makes sense to you.

= @ Form Wizard . . .
% In this lesson, you will learn how to create and modify forms. You'll also learn how to use form

ElNa\tigation = . ; N !
Fornly Blank options like design controls and form properties to make sure your form works exactly the way
Design Form %More Forms = titt
A you want it to.

Form Design

Create a new blank form in Design
view.

We will be showing you how to create forms with examples from our sample bakery database. If you would like to
follow along, download our example and use it to follow the procedures demonstrated in this lesson.
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Creating forms

Access makes it easy to create a form from any table in your database. Any form
you create from a table will let you view the data that's already in that table and Video: Creati ng Formsin
add new data. Once you've created a form, you can also modify it by adding Access 2010

additional fields and design controls such as combo boxes.

g Blv 0 EH

To create a form:

1. In the Navigation Pane, select the table you would like to use to create a form. You do not need to open the table.
2. Select the Create tab on the Ribbon, and locate the Forms group. Click the Form command.

External Data Database Tools

Create

Home

EL E E j @ @ =] | L= Z 8] Form Wizard
=8 == G
=] o =] [E] Wavigation -
Application | Table Table SharePoint | Query Query Form = Form Blank

Parts - Design  Lists = Wizard Design .Jesign Farm EI More Forms ~
Templates Tables Queries % Forms
All Access Objects = « Form
|Sea:ch... |P Create a form that lets you enter
Tables =z R L?n:zﬁmation for one record ata

0 Press F1 for more help.

E Categories .

I = customers

3. Your form will be created and opened in Layout View.
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| Customers
¥
1
Tracey
Beckham
= East Walker Dr.
NC
27012
beck@email.oom

919-555- 2314

Raleigh

D - Paid = Pre Order -
38 Yes No
- (New) No N

- [Fickap Dat -
12/24 /2010

Record: W laofl LU Search

4. To save the form, click the Save command on the Quick Access Toolbar. When prompted, type a name for the form, then

click OK.
Save As [ ? iE-J
Form Mame:

Customers Form

OK. J\ ’ Cancel
X

If you created a form from a table whose records are linked to another table, your form probably includes a subform. A subform
is a datasheet form that displays linked records in a table-like format. For instance, the subform included in the Customers form
we just created displays linked customer orders.

We probably don't need to include this subform, since we really just want to use the Customers form to enter and review contact
information. If you find that you don't need a subform, you can easily delete it. Simply click it and press the Delete key.
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Customers

First Mame ' Hakim
Last Name Auden
Street Address 921 Dawson St
State .
_NC Our Customers form
Zip Code 27600 contains a subform with

each customer's order
Email hauden@email.com information. This is more
information than we need to
see on this form.

Phone Mumber 919-555-0045

City Raleigh
Jr
Add to Mailing List? | Yes- Special Offers Only
. ID - Pid - PreOrder - Notes - | Pickup Date -
# 9 Yes Mo 1271472010
* (New) No No
Record: 4 < b M | R Mo Filter | Search

However, subforms aren't always useless. Depending on the content and source of your form, you might find that the subform
contains useful information, as in the example below. In our Orders form, the subform contains the name, quantity, and price of

each item contained in that order, which is all useful information.

= New Order

Our Orders form contains a

Customer | Allenson [z] Order# 63 | subform with the details of
each order. This is useful
Notes For a St. Patrick's Day party. Make everything we can green information, sowe won't
food coloring to cake and cookie dough, green filling in crea delete the subform.

and add on green sprinkles where appropriate.

Cream Puffs
Lemon Sugar

Key Lime

Ginger Shortbread
French Vanilla

$117.00

Record: M < 1of§ | b b b | K NoFilter | Search
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Adding additional fields to a form

When you use the Form command on an existing table, all of the fields from that table are included in that form. However, if you
later add additional fields to that table, those fields will not automatically show up in existing forms. In situations like this, you can
add additional fields to a form.

To add a field to a form:

1. Select the Form Layout Tools Design tab, then locate the Tools group on the right side of the Ribbon.
2. Click the Add Existing Fields command.

I ————..

Design | Arrange Format

I - i

= =] ]

= =0f | B mitte

|=—E « g ’:’ —| Insert ) Add Existing | Property

*| Image - | [5) Date and Time Fielﬁ sheet
ools

Header / Footer

Add Existing Fields

Insert a field into this view, based
on an existing field,

0 Press F1 for more help.

3. The Field List pane will appear. Select the field or fields to add to your form.

o If you want to add a field from the same table you used to build the form, simply double-click the name of the desired
field.

L] Title
Insert
7 Image EDate and Time

Header / Footer
Field List
&-“ Show all tables

Fields available for this view:
(o]

First Name

— Last Mame

— Street Address

State

Zip Code

— Email

Phone Mumber

City

Add to Mailing List?

n

o To add a field from a different table:
1. Click Show All Tables.

2. Click the plus sign + next to the table containing the field you wish to add.
3. Double-click the desired field.
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Field List x

Ein‘-‘ Show all mﬁjles .-
Fields available b/ this view: X

J—-N—

Fields available for this view:
[= Customers Edit Table

(o]

First Name

Last Mame

Street Address

State

Zip Code

Email

Phone Mumber

City

Add to Mailing List?

Other Motes

.Fields available in related tables:
Orders Table Edit Table
(o]
Customet@
Paid
Pre Order
Motes
Pickup Date

Fields available in other tables:

Categories Edit Table
Menu Items Edit Table
Order Items Edit Table
Orders: December 2010 Edit Table
Products Table Edit Table
Sales Unit Edit Table

EIEFE

4. The new field will be added.

e LA s Eesamr

City Raleigh

Add to Mailing List?

Other Notes

You can also use the above procedure to add fields to a totally blank form. Simply create a form by clicking the Blank
Form command on the Create tab, then follow the above steps to add the desired fields.

oase Tools f Design Arrange Format l

c= D @FormWizard E
== mrm

E| Mavigation = o

Farm Form @ EBlank Report Rep
Design  Form EIMO"E Forms - Desi
Formlg Re

istomers Form j =| Blank Form

Create a form with no controls or |
format.
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Page 4
Adding Design Controls

Design Controls set restrictions on the fields in your forms. This helps you better control how the data is entered into your forms,
which in turn helps keep the database consistent.

A combo box is a drop-down list you can use in your form in place of a field. Combo boxes limit the information users can enter
by forcing them to select only the options you have specified.

Combo boxes are useful for fields that have a limited number of possible valid responses. For instance, you might use a combo

box to ensure people only enter a valid U.S. state while entering an address, or that they only choose products that already exist
in your database while placing an order.

1. In Form Layout view, select the Form Layout Tools Design tab, and locate the Controls group.
2. Select the Combo Box command, which looks like a drop-down list.

--

ools [ Design | Arrange Format
jgﬂﬁ%ﬁv
Controls

Combo Box

e
3. Your cursor will turn into a tiny crosshairs and drop-down list icon . Move the cursor to the place where you would

like to insert the combo box, and click. A yellow line will appear to indicate the location where your combo box will be
created.

In our example, the combo box will be located between the City field and the Add to Mailing List? field.

P B RN T

City Raleigh

4. The Combo Box Wizard dialog box will appear. Select the second option, I will type in the values that I want, then click
Next.
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7

Combo Box Wizard Fe 1

This wizard creates a combo box, which displays a list of values you
can choose from. How do you want your combo box to getits
values?

() Iwant the combe box to get the values from another table or
query.

@[Li will type in the values that I want.

(7 Find & record on my form based on the value T selected in my
~ combo box.

5. Type in the choices you would like to appear in your drop-down list. Each choice should be on its own row.

In our example, we are creating a combo box for the Add to Mailing List? field in our form, so we will enter all of the
possible valid responses for that field. Users will be able to select one of three choices from our finished combo box: "No",
"Yes-Weekly", and "Special Offers Only".

Combo Box Wizard r

What values do you want to see in your combo box? Enter the number of columns you want in
the list, and then type the values you want in each cell.

To adjust the width of a column, drag its right edge to the width you want, or double-dick the
right edge of the column heading to get the best fit.

Mumber of columns: |1_

Coll
Mo
‘fes- Weekly
W special Offers only
*

[ Cancel ] [ < Back H MNext = ] ’ Finish ]

6. If necessary, resize the column so all of your text is visible. Once you are satisfied with your list, click Next.

Combe Box Wizard Fe |

What values do you want to see in your combo box? Enter the number of columns you want in
the list, and then type the values you want in each cell,

To adjust the width of a column, drag its right edge to the width you want, or double-dick the
right edge of the column heading to get the best fit,

MNumber of columns: ll_

Coll
Mo ’

‘Yes- Weekly
Yes- Spedal Offers

*

[ Cancel ] [ < Back ” Mext = ] [ Finish ]

7. Select Store that value in this field, then click the drop-down arrow and select the field where you would like selections
from your combo box to be recorded. After making your selection, click Next.
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Combo Box Wizard

Microsoft Access can store the selected value from your combo box
in your database, or remember the value so you can use it later to

perform a task. When you select a value in your combo box, what
do you want Microsoft Access to do?

(7) Remember the value for later use.
Store that value in this field:

i}

First Mame
Last Name
Street Address

Phone Mumber
City
Add to Mailing List?

[ Cancel ] [ < Back H Mext = ] ’ Einish ]

8. Enter the label, or the name that will appear next to your combo box. Generally, it's a good idea to use the name of the
field you chose in the previous step.

P —

Combo Box Wizard

What label would you like: for your combo box?
|Add to Mailing List?] |

Those are all the answers the wizard needs to create your combo
box,

(o) (o)

9. Click Finish. Your combo box will appear on the form. If you created your combo box to replace an existing field, delete
the first field.

In our example, you might notice that we now have two fields with the same name. These two fields send information to
the same place, so we don't need them both. We'll delete the one without the combo box.

The combo box E

Add to Mailin

]
il
+

.l

1 Add to Mailing Li

! Other Notes \

The "Add to Mailing
List?" text entry field,
which we will delete

m

LM

)

3

=
Ev

10. Switch to Form view to test your combo box. Simply click the drop-down arrow and verify that the list contains the correct
choices. The combo box can now be used to enter data.
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Phone Mumber 919-555-2314

City Raleigh

Yes- Weekly
Yes- Special Offers Only

If you want to include a drop-down list with a long list of options and don't want to type them all out, create a combo
box and choose the first option in the combo box wizard, I want to get the values from another table or query. This
will allow you to create a drop-down list from a table field.

" ~

Combo Box Wizard

This wizard creates a combo box, which displays a list of values you
can choose from. How do you want your combo box to getits
values?

ig) 1 want the combo box to get the values from another table or
query.

(7 Twill type in the yphiss thatr 3

() Find a record on n
~ combo box. — | 3

Augerot Yann 219-555-06 -

Firs 919 06
Wujek Andrze| 919-555-04
/'Whirrt;.- Jaquon 919-555-05
. Storey Zavion 919-555-05

Bryson Jar'Nae 919-555-05

@ Watson Takevia 919-555-05
Bell Xy'niya 219-555-07

-
White Kle'Alp 219-555-02
This combo box gets its Haollings Lane 919-555-02
values from three fields Tappen Matthew N0
in the Customers table Ullman Alyssa F13.555-57
|ackson Ta'Myiz 919-555-59
Price I'mmoni 919-555-68
Blue Lailz 19-555-61
Miebo Makeda 919-555-65 =

Some users report that Access malfunctions while working with forms. If you have a problem performing any of these
tasks in Layout view, try switching to Design View.

Page 5

Customizing form settings with the Property Sheet

The Property Sheet is a pane containing detailed information about your form
and each of its components. From the Property Sheet, you can make changes to
every part of your form, both in terms of function and appearance.

The best way to familiarize yourself with the property sheet is to open it and

select various options. When you select an option, Access will display a brief
description of that option on the bottom-left border of the program window.
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Format

Visible

Width

Watch the video to learn how to use the Property Sheet to change form settings.

l w | [ 5 Emplovee Database avigation | 2| Customers F Select an option to see Sheet
A . ction type: Form
—_] Customers a description of it at the E
-1 " : bottom of the screen
First Name Tracey
Beckham
Street Address 7 East Walker Dr.

XT612

Border Style
Reznrd Sebectors

Navigation Buttans
Navigation Caption

Mawvigation Pane

back @ermail. com

ne Numbe e Dividing Lings
Phone Mumber Y
one Numbe 919-555-2314 covall Eare
Cantrod Box
Close Button
Raleigh Min Max Buttons

Maveabie

Split Fosm Size

Split Foem Orientation
Split Fosm Spadter Bar
Split Fosm Datasheet
&plit Form Frinting

Sawe Spitter Bar Position
Subdstasheet Expanded
- || Subasashest Height

X
LBespeg w  gorgol v wobo | Lpo e 1 - Grid
ew in which the chject is displayed when # apens|

Add to Mailing List? No

Mo
Ter
Embedded

Auta

Datashast on Top

fes

Allow Edits

Farm Only

ez

Ho

1]

M -

==

Decimal Places

Show Date Picker For dates

Auto

ves||

6.0521°

Pay close attention as you modify your form and its fields. It's possible to make subtle changes with the Property Sheet.
Because there are so many options, it can sometimes be challenging to remember which one you used to modify each

aspect of your form.

Modifying form settings

There are far too many options in the Property Sheet to discuss them all in detail. We'll review two useful ones here: hiding fields,
and setting fields with dates to automatically fill in the current date. Practicing these procedures should give you a sense of

how to work with other Property Sheet settings as well.

To hide a field:

1. In either Layout or Design view, select the Design tab, and locate the Tools group. Click the Property Sheet command.

i

Add Existing Property
Fields 5[aet

Toals

Property Sheet (Alt+ ENTER)

COpen this object's property sheet
to set its properties.
T

2. The Property Sheet will appear in a pane on the right. On the form, select the field you wish to hide. In our example, we'll

http://www.gcflearnfree.org/access2010/13/print
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hide the Customer ID field, since we don't want any of our users to edit it.

abase Mavigation ‘ :__:'| Customers Fonn b4

.ustomers

i Search

i First Name | Tracey

i Last Name |Beckham

Property Sheet X
a | 2election type: Text Box

E B

----------------- grossanassnananney |Format| Data | Event I D‘I:her| All |

1

Filter Lookup Database Default -
Enabled Yes
Locked Mo
On Click

Before Update
After Update
On Dirty

On Change
On Got Focus
On Lost Focus

3. In the Property Sheet, click the Format tab, and locate the Visible option on the third row.

4. Click the drop-down arrow in the column to the right, and select No.

Property Sheet
Selection type: Text Box

1D

[=]

Format | Data | Event | Other | AN |

x

Format

Visible
Show Date Picker
Width
Height

Tan

5. Switch to Form view to verify that the field is hidden.

1. In either Layout or Design view, select the Design tab, and locate the Tools group. Click the Property Sheet command.

B
i
Add Existing Property

Fields Sheet
Toaols

to set its properties.

Property Sheet (Alt=ENTER)
Open this object’'s property sheet

2. The Property Sheet will appear in a pane on the right. On the form, select the field you would like to automatically fill in
the current date. This must be a field with the date data type. For our example, we'll select the Pickup Date field on our

Orders form.

¥ | Property Sheet X
& || Selection type: Text Box
Pickup Date |Z|
Format | Data | Event | other | an |
Pickup Date o Format [+] =
{% Decimal Places Auto H
Visible Yes |
Cere order Show Date Picker For dates
Width 1.1042°
FlPaid Height 0.25°
Top 1"

3. In the Property Sheet, click the Data tab, and select the Default Value field in the fourth row. Click the Expression

Builder button [ that appears in

the column to the right.

http://www.gcflearnfree.org/access2010/13/print
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Property Sheet X

Selection type: Text Box

|Pickup Date |z||

|Format| Data | Event | other | an |

Control Source Pickup Date

Text Format Plain Text

Tnout Mask

Default Value i E]
ahdation Hule T g

WValidation Text

Filter Lookup Database Defa

Enabled Yes

Locked Mo

Smart Tags

4. The Expression Builder dialog box will open. In the Expression Elements list, click the words Common Expressions.
5. In the Expression Categories list, double-click Current Date.

,
A ——

Enter an Expression to define the conirol property value:
(Examples of expressions indude [field1] + [fieldZ] and [field1] < 5)

: K

:

Cancel

[ ren |
<< Less

Expression Elements Expression Cateqgories Expression Values
[#-[55] Orders
\ Current Date/Time
] I r
i
||
== = =

6. The expression for Current Date will be added. Click OK.
(e e, e

Enter an Expression to define the control property value:
(Examples of expressions indude [field1] + [fieldZ] and [field1] < 5)

I Date() § | Qk
Help
[<<less |
Expression Elements Expression Categories Expression Values

-[=5] Orders
f2) Functions Current Date/Time

h| Semi-final database-- throi
Constants
Operators
Common Expressions

S =

7. Switch to Form view to verify that the expression works. When you create a new record with that form, the date field you
modified will automatically fill in the current date.
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= New Order

b Ny |

Customer

Challenge!

5. Switch to Form view, and click on the drop-down arrow in the combo box you created. You should see a list of cities.

http://www.gcflearnfree.org/access2010/13/print

Delete the subform.
. Create a combo box.

o Add the following choices to the combo box:

o Raleigh

o Durham

o Hillsborough
o Cary

o Chapel Hill
o Garner

o Charlotte

o Store the value in the City field, and label the combo box NC City List. Click Finish when you are done with the

Combo Box wizard.

1
2. Create a form from the Customers table.
3.
4

=]
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Order #

. If you haven't already, download our sample database and open it.

Pickup Date | 3/16/2011

[T pre order

[ paid

Page 6
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